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UNNGÅ DE TYPISKE FEILENE
I OPPSETTET DITT
Etter å ha behandlet flere millioner trykkordre vet vi  
at over 90 % av feilene oppstår på de samme stedene!

Følg guiden vår og du er godt på vei.
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Vi anbefaler ...
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Seks sjekk, så er du klar

EKSPORT AV FILER
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GRATIS FILSJEKK
Vi er klare til å veilede deg!
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SEKS DESIGNTIPS
1. SEND KORREKT BESTILLING

Husk å opplyse alle bestillingsdetaljer når du sender ordren din.

Typiske bestillingsdetaljer:
	Ì Produkt (hvilken trykksak du ønsker)
	Ì Opplag (hvor mange du skal bruke)
	Ì Ditt telefonnummer – gjerne mobil
	Ì Forsendelsesadresse
	Ì Faktureringsadresse

Bestill på www.lasertrykk.no og unngå problemer. 
Ved å bestille via hjemmesiden er du sikret at vi mottar all relevant informasjon.

2.  BRUK KORREKTE FARGER

Vi trykker alt med fire CMYK-farger med unntak av enkelte trykksaker med Pantone-farger.

Husk trykkfil i CMYK-farger
I de fleste grafiske programmer kan du velge å arbeide i CMYK-farger  
(fremfor RGB-farger).

Last ned vår CMYK-guide
Last ned vår CMYK-guide, hvor du finner et bredt utvalg av CMYK-fargeprøver.  
Du kan laste ned fargemapper på www.lasertrykk.no/fargefolder.

Slik defineres fargen sort
Skal du definere fargen sort (til dekkflate) med CMYK-farger, får du best resultat ved å velge:  
C=60 M=40 Y=40 K=100. Sort tekst og strek-tegninger skal defineres som C=0 M=0 Y=0 K=100.

Pantonefarger
Som nevnt trykkes enkelte av våre trykksaker med Pantone, dette er spesialfarger som ikke kan skapes med 
CMYK-skalaen. Dette gjelder alltid offsettrykksaker som konvolutter og brevpapir, disse skal ha en eller flere 
Pantone-farger.

https://lasertrykk.no/
https://www.lasertrykk.no/content/dat/download/FOLDER_2021_WEB_v1.pdf


3. BENYTT KORREKT FILTYPE

Vi kan håndtere alle filtyper, kjente som ukjente. Det beste resultatet får du hvis du benytter 
PDF-format med alle fontene inkludert i filen.

ANDRE POPULÆRE FILTYPER

Tif/jpg
I nesten alle grafiske programmer kan man lagre i bildeformatene tif og jpg. 
Lagre filen i maksimumkvalitet, i CMYK-farger og min. 300 dpi. 
Er det tekst på trykksaken anbefaler vi min. 600 dpi for optimal skarphet.

Eps
Et populært vektorformat som typisk gir bedre resultat enn tif/jpg. Husk å konvertere alle fonter til kurver (vektorisert/
outlined). Fonter kan også være inkludert i filen.

InDesign, Photoshop og Quark
Eksporter til PDF-format – se ovenfor. Alternativt eksporter til eps, og åpn eps-filen i Illustrator, konverter alle fonter til 
outlines, og lagre som eps/PDF.

Microsoft Office (Word, Excel, PowerPoint, Publisher)
Utskriv til PDF-format (krever Adobe Acrobat eller vår gratis PDF-writer – se download-seksjon).

Husk at Microsoft Office-formatene ikke er beregnet til grafisk bruk, og vi påtar oss ikke ansvaret for fargene i den 
endelige trykksak.

Gratis PDF-generator
På www.lasertrykk.no/downloads kan du downloade en gratis PDF-writer og selv lage PDF-filer.

4. KORREKT OPPLØSNING  (PPI)

Ved å bruke korrekt dpi unngår du at din trykksak blir kornete og uskarp. Som utgangspunkt skal trykkfiler 
ligge i 300 ppi. Vi anbefaler dessuten å ikke lage tekst som bitmap.

DPI eller PPI?
Selv om DPI (punkter per tomme) og PPI (piksler per tomme) vilkårene begge beskriver  
oppløsningen (eller klarheten) av et bilde, er de ikke det samme.

PPI beskriver antall piksler som vises per tomme på en skjerm. 
DPI brukes til utskrift, og beskriver antall fysiske prikker med blekk på trykksaker.

	Ì Bilder og leseavstand,  f.eks en folder (10-50 cm): min. 150 ppi – 300 ppi for optimalt resultat.
	Ì Bilder på ståavstand, f.eks plakater, roll-ups og liknende (min. 50 cm): min. 60 ppi – helst 100 ppi.
	Ì Bilder på bannere, som leses på flere meters avstand: 5-50 ppi avhenging av om leseavstanden er  

5 eller 20 meter.

5 ppi høres helt tullete ut, men faktisk betyr det at hver pixel er 0,5 x 0,5 cm – en så liten prikk kan man ikke 
se på 20 meters avstand – derfor kan 5 ppi være helt fint.

EPS

EPS

EPS

https://lasertrykk.no/downloads


5. HUSK PLASS TIL BESKJÆRING

Dette er det viktigste rådet, da det er her vi opplever flest feil.

Ekstra 3 mm i layoutet
Det viktigste er at du husker å legge til 3 mm på alle sider av trykksaken, også kalt ”bleed”. 
Tekst og grafiske elementer bør ha en sikkerhetsavstand på minst 3 mm fra den siste kanten av trykksaken.

Unngå problemer med beskjæring ved å benytte en av våre maler.
Se flere beskjæringstips i dokumentoppsetting.

6. OVERPRINT OG OUTPUT

Unngå å bli overrasket over at noe forsvinner!

InDesign, Illustrator og Acrobat kan stilles inn til å alltid vise overprint 
- dermed vil du oppdage eventuelle problemer med layoutets fargelag.

Overprint i InDesign og Illustrator:
Slå på Overprint Preview i InDesign så vil alt layout simulere det ferdige trykket: 
InDesign > View > Overprint Preview.  
Se guide.

Overprint i Acrobat Pro:
Oppdag feil når den trykkeklare PDF-en gjennomgås. Det anbefales å alltid ha overprint-visning slått på:  
Edit > Preferences > Page Display > Page Content and Information > Use Overprint Preview > Always.  
Se guide.

Output Preview-verktøy i Acrobat:
Du kan også bruke Output Preview som verktøy. Slå på “Simulate Overprint” i Acrobat: 
View > Tools > Print Production > Output Preview > Simulate overprinting.  
Se guide.

Se vår videoguide her, som viser  
hvordan du lager beskjæring i InDesign.

Se også videoen vår her og forstå hvordan 
minimale svingninger kan påvirke designet ditt.

Se filmenSe filmen

Overprint Ikke overprint

https://lasertrykk.no/maler
https://www.lasertrykk.no/gfx/indesign.png
https://www.lasertrykk.no/gfx/pdf-pro.pdf
https://www.lasertrykk.no/gfx/pdf-vaerktoej.pdf
https://www.youtube.com/watch?v=FUtCFCyRP6w
https://www.youtube.com/watch?v=Diw1rvnaP08&t=2s


MALER
Vi anbefaler at du bruker en av våre maler når du designer trykksaken din.
Når du benytter malene unngår du problemer med beskjæring, dokumentstørrelse m.m. 

Malene er plassert i en ZIP-fil, hvor du finner:

	Ì Mal i PDF-format
	Ì Mal i InDesign-format
	Ì Våre eksport-innstillinger
	Ì Dokumentet ”Slik designer du din trykksak.pdf”

Du får tilgang til alle maler på www.lasertrykk.no/maler.

DOKUMENTOPPSETNING
Slik gjør du det hvis du ikke vil bruke malene våre.

1. Start et nytt dokument 
Kan også hete ”ny side”, ”nytt canvas” eller ”nytt artboard”. 

2. Dokumentoppsetning  – InDesign 
Sett dokumentstørrelsen til trykksakens ferdige mål; f.eks. postkort (105 x 148 mm). 

3. Sett in 3 mm beskjæringssone og 3 mm sikkerhetssone  
Dette gjøres i menyen ”Nytt dokument”, ”Beskjæring og satslinje”. 

4. Dokumentoppsetning  – andre programmer 
Hvis du ikke kan sette inn bleed i programmet, kan du stille inn dokumentstørrelsen 
3 mm større enn den endelige størrelsen på trykksaken på alle fire sider.  
Dette kalles ”legge til beskjæring”. 
 
Eksempel på tillegg av 3 mm beskjæring:
Trykksak Ferdig mål Dokumentstørrelse
A6-postkort 105 x 148 mm 111 x 154 mm

Visittkort 85 x 54 mm 91 x 60 mm

A5-flyer 148 x 210 mm 154 x 216 mm
 
Heretter settes det inn en sikkerhetssone hele veien rundt i  
dokumentet, 3 mm fra trykksakens endelige størrelse.

Download

Maler 

Beskjæringszone
Bakgrunnsgrafikk og bakgrunnsfarger
skal gå helt ut til kanten, det vil si 3 mm
utover den endelige kant.

Endelig kant
Endelige format på trykksaken etter beskjæring.

Sikkerhetszone
Tekst, bilder og logoer bør plasseres
i den hvite sonen (3 mm fra den ytre kanten).

NO_skabelon.indd   1NO_skabelon.indd   1 30-11-2021   11:41:4130-11-2021   11:41:41

https://lasertrykk.no/maler


DE TRE BESKJÆRINGSTIPSENE

Hvis nedenstående tre beskjærings-tips følges, vil det sjeldent oppstå feil.

TIPS 1
Design filen i korrekt størrelse fra begynnelsen av!

Endelig format: 
Layout-format 

(arbeidsområde):
A0-format (841 x 1189 mm) 847 x 1195 mm

A1-format (594 x 841 mm) 600 x 847 mm

A2-format (420 x 594 mm) 426 x 600 mm

A3-format (297 x 420 mm) 303 x 426 mm

A4-format (210 x 297 mm) 216 x 303 mm

A5-format (148 x 210 mm) 154 x 216 mm

A6-format (105 x 148 mm) 111 x 154 mm

A7-format (74 x 105 mm) 80 x 111 mm

Visitkort (54 x 85 mm) 60 x 91 mm

TIPS 2
Grafikk som skal ut til kanten skal fylle hele arbeidsområdet!

TIPS 3
Ikke plasser tekst for nær kanten!

Feil tekstplassering – riktig bakgrunn Riktig plassering av både tekst og bakgrunn

Feil plassering av bakgrunnsgrafikk Korrekt plassering av bakgrunnsgrafikk
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HVORFOR RAMMER OG TEKST IKKE ANBEFALES

Se hvordan et ”skjevt” kutt på bare 1 mm påvirker et layout som ”i teorien” er greit. 
Hvis vi kunne kutte mer presist enn +/- 1 mm, var 3 mm for beskjæring ikke nødvendig – men det er det.

Teori: Rammen skal være 2 mm bred 
over alt. 

Praksis: Rammen kommer til å være  
1 og 3 mm bred.

Teori: Rammen skal sitte 3 mm fra kanten  
hele veien rundt.

Praksis: Rammen kommer til å sitte  
2 og 4 mm fra kant.

Teori: Den høyre- og venstrestilte teksten  
skal være plassert 3 mm fra kant.

Praksis:Teksten kommer til å sitte  
2 og 4 mm fra kant.

Virksomhet
Adresse 99
1176 Post kode

Tlf.: 88 88 88 88
Mobil: 88 55 88 55

navn@virksomhet.no

Kjell Kalmar
Chef

Virksomhet
Adresse 99
1176 Post kode

Tlf.: 88 88 88 88
Mobil: 88 55 88 55

navn@virksomhet.no

Kjell Kalmar
Chef



PREMIUM TRYKKFILER
Selv om vi er store tilhengere av at det skal være enkelt, stiller denne typen foredling noen krav til trykkfilen 
din. Denne korte guiden tar utgangspunkt i InDesign, men prinsippene er de samme uansett hvilket (egnet) 
program som benyttes til utarbeiding av trykkfiler.

Vi kan påføre tre effekter:
	Ì Gullfolie
	Ì Sølvfolie
	Ì 3D-lakk

Hver effekt som brukes skal defineres i trykkfilen som en unik spottfarge (staf-
fasjefarge). Hvilke farger som brukes til de forskjellige effektene er underordnet, 
men optimal kontrast til selve trykkfilen er en fordel.

Delvis lakk navngis «VARNISH», sølvfolie «SILVER» og gullfolie «GOLD» 
- alltid med store bokstaver.

OVERPRINT

Overprint skal alltid brukes på de delvise elementene, uansett om det ligger trykkfarge  
under effekten eller ei.

OVERLAP 

Effekter som overlapper skal slå hull, så det ikke legges flere lag oppå hverandre. Det skyldes at det brukes 
lakk som kleber på folien og lag med overlap vil derfor bli for tykke. Fig. A1 til venstre viser de tre variantene i 
den ferdige filen. Fig. A2 viser elementene trukket fra hverandre.

SMÅ ELEMENTER

Vær oppmerksom på at delvis lakk og folie fungerer best, hvis elementene ligger minimum 3 mm fra 
hverandre, fra kanten og/eller brett (fold). Vi anbefaler ikke punktstørrelser under 12 pkt.

Fig. A1 Fig. A2

VARNISH (lakk) SILVER (sølv) GOLD (gull)



MISPASS

Da hver effekt legges på trykkarket i en særskilt arbeidsgang, så kan mispass forekomme på elementer med 
liten toleranse (fig. B1). Sørg alltid for å ta høyde for dette i designet. Fig. B2 viser et mispass på kun 0,3 mm.

NEGATIV EFFEKT

Ønskes negativ effekt i folien skal elementer, eksempelvis tekst som vist til høyre (Fig. C1), ha en viss 
toleranse. Gullfolien overlapper den bakenforliggende grafikken, samtidig som det er tatt høyde for mispass. 
Fig. C1 er laget med en hvit kasse som bakgrunn (Fig. C2). 
Samme oppgave kan også løses med en stroke (Fig. C3).

Fig. B1 Fig. B2

VARNISH (lakk) SILVER (sølv) GOLD (gull)

Ficipiet fuga. Mint 
occusa que plignis et 
ad eatem rerum aut 
et andis est, quam 
ratem quam lia niet 
labor alMo tem inc-
tem. Dam alibusdae

Ficipiet fuga. Mint Ficipiet fuga. Mint 
occusa que plignis et occusa que plignis et 
ad eatem rerum aut ad eatem rerum aut 
et andis est, quam et andis est, quam 
ratem quam lia niet ratem quam lia niet 
labor alMo tem inc-labor alMo tem inc-
tem. Dam alibusdaetem. Dam alibusdae

Fig. C1 Fig. C2 Fig. C3



FARGEPROFILER
Ì Til bestrøket (coated) papir, f.eks. Silk, anbefaler vi FOGRA39.
Ì Til ubestrøket (uncoated) papir, f.eks. offset, anbefaler vi FOGRA47.

EKSPORT AV FILER
Vi anbefaler, at du laster ned og installerer våre eksportinnstillinger, hvis du designer din trykksak med hjelp 
av Adobes programmer (InDesign, Illustrator og Photoshop).

SLIK FUNGERER DE

1. Last ned zip-filen og pakk den ut
2. Dobbeltklikk på filen ”LaserTryk.dk.joboptions” (InDesign/Photoshop/Illustrator skal være lukket)
3. Eksport-innstillingene er nå installert og finnes i din InDesign-meny.
4. Velg ”File” – ”Adobe PDF Presets” – ”SPG 2020”

Last ned eksportinnstillinger i QR-koden eller her: www.lasertrykk.no/downloads. 

FORDELEN VED EKSPORTINNSTILLINGER

Når du bruker eksportinnstillingene våre, er du sikker på at du kontrollerer:

• Problemer med transparens
• Problemer med beskjæring
• Problemer med manglende fonter
• Problemer med unødvendig høy oppløsning

KORREKT EKSPORT – ENKELTSIDE ELLER OPPSLAG

Når du eksporterer trykkfilen fra InDesign, kan du velge å eksportere sidene
som enkeltsider eller oppslag.

	Ì Størstedelen av trykksakene må eksporteres som enkeltsider i ett dokument (pdf) 
      og i riktig rekkefølge.
	Ì Omslag og foldere skal eksporteres som oppslag i ett dokument (pdf),  

      og sidene må være riktig sammensatt.  
      Husk å sette inn en rygg, hvis det er en limt bok.

Download

Unavngivet 1   2-3Unavngivet 1   2-3 29-11-2021   11:19:0329-11-2021   11:19:03
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Opslag

Enkeltsidet

https://lasertrykk.no/downloads


SJEKKLISTE INNEN UPLOAD
   Korrekt beskjæring 

Jeg har laget korrekt beskjæring og trykkfilen min er derfor 3 mm større på alle kanter enn den endelige 
trykksaken.

   Korrekt sikkerhetssone 
Jeg har plassert tekst, grafikk og logoer innenfor for sikkerhetssonen (minimum 3 mm fra trykksakens 
kant). 

   Korrekt oppløsning 
Alle bilder i min trykkfil har en oppløsning på minimum 300 dpi, når de er plassert i 100 % i dokumentet. 
Psssst... Er du i tvil, om for eksempel oppløsningen er god nok, så forstørr skjermen din til 200-300 %. 
Hvis det fortsatt ser skarp og ikke-pikselert ut, vil den også se bra ut på trykk.

   Korrekte farger 
Trykkfilen min er laget med CMYK-farger. Har jeg satt inn bilder eller annet i RGB/Pantone-farger, lar jeg 
LaserTrykk.no konvertere til CMYK-farger, for å få det beste resultat. Jeg er klar over at fargene kan endre 
seg under konverteringen. 

   Korrekte PDF med fonter inkludert 
Alle fonter ble embedded/inkludert da jeg eksporterte PDF-filen min. Hvis du bruker våre eksportinnstillin-
ger (se her) eller hvis du eksporterer du som ”high quality”/”press quality”, skjer dette automatisk.

   Ingen oppslag (ved trykksaker med flere sider) 
Min PDF-fil inneholder sidene fortløpende. En 24 sider hefte krever altså en PDF-fil med 24 sider. Send 
derfor ikke PDF-filer med sidene plassert mot hverandre / som oppslag. Hvis du ønsker å ha et sterkere 
omslag på heftet ditt, må du  sende omslaget som en egen trykkfil.

GRATIS FILSJEKK
Er du i tvil om filen din kan brukes til trykk, tilbyr vi å sjekke den før trykk – gratis og uforpliktende.

Vi sjekker din fil for:
	Ì Korrekt beskjæring
	Ì Korrekt oppløsning (dpi)
	Ì Format / filtype
	Ì Korrekte farger 

Se mer på www.lasertrykk.no/filsjekk. 

https://lasertrykk.no/filsjekk
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